
Kinetic AssistantKinetic Assistant is a SimConnect utility that covers missing simulation or is a SimConnect utility that covers missing simulation or
gameplay elements of the gameplay elements of the Microsoft Flight SimulatorMicrosoft Flight Simulator (2020). Desktop (2020). Desktop
application read sim variables and return adjusted values (like speed andapplication read sim variables and return adjusted values (like speed and
rotation) back into the game to simulate some specific conditions, uplift inside ofrotation) back into the game to simulate some specific conditions, uplift inside of
artificial thermal for example. Also it can insert objects into the game, like AI towartificial thermal for example. Also it can insert objects into the game, like AI tow
planes.planes.

Currently these features are available: Currently these features are available: WinchWinch, , AerotowAerotow, , ThermalsThermals, , CatapultCatapult
and and Arresting gearArresting gear. All of them have limitations, so please read the description. All of them have limitations, so please read the description
for each below.for each below.

* Kinetic Assistant also integrated into * Kinetic Assistant also integrated into ALBATROSS competitions appALBATROSS competitions app < <
https://msfs.touching.cloud/mods/albatross/> https://msfs.touching.cloud/mods/albatross/> , there is no difference in, there is no difference in
functionality between full and integrated versionfunctionality between full and integrated version

* Freeware carriers pack was released by * Freeware carriers pack was released by superspud superspud on on flightsim.toflightsim.to < <
https://flightsim.to/file/4930/aircraft-carrier-uss-msfs-uk-mooring> https://flightsim.to/file/4930/aircraft-carrier-uss-msfs-uk-mooring>  and not and not
included into packageincluded into package

* Freeware glider add-on * Freeware glider add-on DG808SDG808S available on  available on msfs.touching.cloudmsfs.touching.cloud < <
https://msfs.touching.cloud/mods/ms-dg-808s/> https://msfs.touching.cloud/mods/ms-dg-808s/>  and not included into and not included into
package as wellpackage as well

* Hotspots data provided by * Hotspots data provided by thermal.kk7.chthermal.kk7.ch < https://thermal.kk7.ch/>  < https://thermal.kk7.ch/> onlineonline
service. This is freeware project, so if you like it – they have donation button inservice. This is freeware project, so if you like it – they have donation button in
the Feedback section!the Feedback section!

Kinetic AssistantKinetic Assistant
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* Offline hotspots data provided by * Offline hotspots data provided by maps.openAIP.netmaps.openAIP.net < <
http://maps.openaip.net/> http://maps.openaip.net/> service.service.

This is an open source project – if you are a developer and wish to contribute, orThis is an open source project – if you are a developer and wish to contribute, or
just curious about how it works – find just curious about how it works – find msfsKineticAssistantmsfsKineticAssistant project on  project on GitHubGitHub
(link in the header).(link in the header).

�. Requirements�. Requirements

Microsoft Flight Simulator (2020)Microsoft Flight Simulator (2020)

.NET Framework 4.7.2 or higher.NET Framework 4.7.2 or higher

Microsoft Visual C++ 2015-2019 RedistributableMicrosoft Visual C++ 2015-2019 Redistributable

�. How to install and launch�. How to install and launch

1. Unpack archive content (do not place it inside of Community folder)Unpack archive content (do not place it inside of Community folder)
2. Launch “Kinetic Assistant.exe” fileLaunch “Kinetic Assistant.exe” file
3. Launch Microsoft Flight Simulator (2020)Launch Microsoft Flight Simulator (2020)
4. Choose aircraft and start the flightChoose aircraft and start the flight
5. Press Press CONNECTCONNECT  button in the program windowbutton in the program window
6. Choose the tab you are planning to useChoose the tab you are planning to use
7. Set controls for required buttons if you are not willing to leave program on theSet controls for required buttons if you are not willing to leave program on the

screenscreen
8. Follow instructions for selected tabFollow instructions for selected tab

�. How to uninstall�. How to uninstall

Remove program folder. If you have used kinetic version prior to 0.7, remove fileRemove program folder. If you have used kinetic version prior to 0.7, remove file
SimConnect.cfgSimConnect.cfg from My Documents folder from My Documents folder

�. Winch�. Winch

http://maps.openaip.net/


�.� User interface�.� User interface

1. String LengthString Length value determines how value determines how
far from takeoff position virtual winchfar from takeoff position virtual winch
will appear. Longer string length willwill appear. Longer string length will
make the towing process longer, andmake the towing process longer, and
final altitude higher.final altitude higher.

2. Higher Higher String SpeedString Speed value will make value will make
towing faster, lower – slower. Too lowtowing faster, lower – slower. Too low
value for your glider performance willvalue for your glider performance will
make climb less effective, as themake climb less effective, as the
airplane will stall instead of gliding.airplane will stall instead of gliding.

3. Initial AccelerationInitial Acceleration is the amount of is the amount of
time that takes winch to acceleratetime that takes winch to accelerate
from zero winch speed to chosen in thefrom zero winch speed to chosen in the
String Speed field.String Speed field.

4. ElasticityElasticity makes the winch pull you makes the winch pull you
harder or softer when tension appears.harder or softer when tension appears.

5. Connection PointConnection Point is the hook that will be used for towing.  is the hook that will be used for towing. Center of GravityCenter of Gravity
hookhook allows you to gain more altitude.  allows you to gain more altitude. NosehookNosehook makes controls easier as makes controls easier as
the string directs your glider to the winch position, but you can’t reach muchthe string directs your glider to the winch position, but you can’t reach much
altitude with it as it will pull you down right after take off – use it for tow planealtitude with it as it will pull you down right after take off – use it for tow plane
only.only.

6. Attach winch cableAttach winch cable button can be pressed when the parking brake is button can be pressed when the parking brake is
engaged.engaged.

�.� How to use�.� How to use

Assistant creates an imaginary winch in a selected distance from the player andAssistant creates an imaginary winch in a selected distance from the player and
then shortens the cable. Cable release can be performed manually, automaticallythen shortens the cable. Cable release can be performed manually, automatically
when climb angle is high enough, or if string fails because of overload (thresholdwhen climb angle is high enough, or if string fails because of overload (threshold
can be increased in settings).can be increased in settings).

To activate winch:To activate winch:

1. shut down engines with shut down engines with Ctrl+Shift+ECtrl+Shift+E



2. in the program set required values: higher in the program set required values: higher String LengthString Length value will make value will make
towing longer so you can get higher altitude, towing longer so you can get higher altitude, String SpeedString Speed will set starting will set starting
winch speed (it will be decreased while you are climbing), winch speed (it will be decreased while you are climbing), Initial AccelerationInitial Acceleration
will adjust speed up duration, will adjust speed up duration, Elastic StretchElastic Stretch – how much string length will – how much string length will
change because of tension (lower value – steel, higher – rubber)change because of tension (lower value – steel, higher – rubber)

3. while you while you on the groundon the ground and  and parking brakes engagedparking brakes engaged, press , press Attach winchAttach winch
cablecable or configured hotkey – virtual winch will be positioned in front of you at or configured hotkey – virtual winch will be positioned in front of you at
the same altitude, at selected distance minus 10m to avoid string tensionthe same altitude, at selected distance minus 10m to avoid string tension

4. Set flaps at Set flaps at 3-5 degrees3-5 degrees
5. when you ready, when you ready, Disengage parking brakesDisengage parking brakes, after 5 seconds delay launch, after 5 seconds delay launch

will happenwill happen
6. if you are on the runway, bank angle of the glider will be leveledif you are on the runway, bank angle of the glider will be leveled
7. hold hold 30-45 degree30-45 degree pitch angle and selected airspeed until you reach required pitch angle and selected airspeed until you reach required

altitude, or winch will start to drag you downaltitude, or winch will start to drag you down
8. on start winch speed will be equal to selected value, but it decreaseson start winch speed will be equal to selected value, but it decreases

dynamically because of high cable tension or high elevation angledynamically because of high cable tension or high elevation angle
9. to release manually, press to release manually, press Release winch cableRelease winch cable button in application or button in application or

configured hotkeyconfigured hotkey
10. if angle to the winch position will be greater than if angle to the winch position will be greater than 70 degrees70 degrees, cable will be, cable will be

released automaticallyreleased automatically

�. Aerotow�. Aerotow

�.� User interface�.� User interface

1. Higher Higher Scan rangeScan range will make further objects appear in the results list will make further objects appear in the results list
2. Elasticity Elasticity acts the same as Winch acts the same as Winch ElasticityElasticity
3. Connection PointConnection Point is recommended to set as  is recommended to set as Nose hookNose hook, as it will make the, as it will make the

towing process simpler. towing process simpler. CG hookCG hook can be used as well, but you will experience can be used as well, but you will experience
problems with holding position behind the towplane.problems with holding position behind the towplane.

4. Scanning TypeScanning Type filtering out results by type. To see online players you should filtering out results by type. To see online players you should
select the Pilots option, as it is the only way to see other players viaselect the Pilots option, as it is the only way to see other players via
SimConnect at the moment.SimConnect at the moment.



5. AI Tow PlaneAI Tow Plane sets a model of the plane sets a model of the plane
that will be inserted into the game afterthat will be inserted into the game after
AI TOWAI TOW button press. List contains only button press. List contains only
default MSFS aircraft, but you can typedefault MSFS aircraft, but you can type
the name of another installed aircraftthe name of another installed aircraft
(full name you can take from Aircraft(full name you can take from Aircraft
Window in Developer Mode). List splitWindow in Developer Mode). List split
in two parts – planes below the line doin two parts – planes below the line do
not work well in the mode, whennot work well in the mode, when
immediate take off happens (immediate take off happens (RealisticRealistic
Tow Plane proceduresTow Plane procedures option option
disabled). You could use them onlydisabled). You could use them only
when taxiing applied before take off.when taxiing applied before take off.

6. SEARCHSEARCH button activates scanning of button activates scanning of
nearest objects. If tow rope connected,nearest objects. If tow rope connected,
this button will disable scanning andthis button will disable scanning and
release the rope at the same time. It isrelease the rope at the same time. It is
recommended to stop scanning after the towing finishes to avoid CPUrecommended to stop scanning after the towing finishes to avoid CPU
consumption.consumption.

7. AI TOWAI TOW button insert towplane into the game. It will exist until you press button insert towplane into the game. It will exist until you press
DISCONNECT DISCONNECT buttonbutton

8. Attach To Closest Attach To Closest will attach rope to the first object in the list. If a connectionwill attach rope to the first object in the list. If a connection
is already made, the button will release the rope and continue to scan.is already made, the button will release the rope and continue to scan.

�.� Multiplayer usage�.� Multiplayer usage

You can attach your glider, or any other aircraft, to another sim object by invisibleYou can attach your glider, or any other aircraft, to another sim object by invisible
rope. By current limitation, the game does not return other players’ aircraft onrope. By current limitation, the game does not return other players’ aircraft on
SimConnect request, so you can connect to the AI/Live traffic planes and groundSimConnect request, so you can connect to the AI/Live traffic planes and ground
service units only. However, most native MSFS planes have pilot objects inside,service units only. However, most native MSFS planes have pilot objects inside,
which can be detected by program. So if tow plane was chosen wisely by anotherwhich can be detected by program. So if tow plane was chosen wisely by another
player, you still can connect cable to it using Pilots item in Type dropdown.player, you still can connect cable to it using Pilots item in Type dropdown.
However, some MSFS planes have issues with pilot position calculation, so can’tHowever, some MSFS planes have issues with pilot position calculation, so can’t
be used as a multiplayer tow plane. Known examples: be used as a multiplayer tow plane. Known examples: DR400 AsoboDR400 Asobo, , CessnaCessna
Skyhawk G1000 AsoboSkyhawk G1000 Asobo, , FlightDesignCT AsoboFlightDesignCT Asobo..



1. set scanning radius (tow rope length is variable – 80m in the air, 40m on theset scanning radius (tow rope length is variable – 80m in the air, 40m on the
ground)ground)

2. select elastic value; as string will be really short and low elastic value can’t beselect elastic value; as string will be really short and low elastic value can’t be
processed properly at such low update rate, minimum total elastic stretch canprocessed properly at such low update rate, minimum total elastic stretch can
be 5m minimum. It means for 100m string, even if 1% set in settings, it will bebe 5m minimum. It means for 100m string, even if 1% set in settings, it will be
5% in fact.5% in fact.

3. select connection point; select connection point; Nose hookNose hook recommended for the towing as make recommended for the towing as make
controls simplercontrols simpler

4. select object type (only these objects will be added into scan result list)select object type (only these objects will be added into scan result list)
5. press press SEARCHSEARCH  buttonbutton
6. in the list find aircraft (or pilot object inside of aircraft) to which you want to bein the list find aircraft (or pilot object inside of aircraft) to which you want to be

attachedattached
7. press on the name labelpress on the name label
8. once tow rope connected, its length will be slowly decreased/increasedonce tow rope connected, its length will be slowly decreased/increased

automaticallyautomatically
9. press on press on aircraft labelaircraft label or  or STOPSTOP  button to release tow stringbutton to release tow string

10. string will be released automatically if angle to the tow plane will be more thanstring will be released automatically if angle to the tow plane will be more than
90 degrees90 degrees in the air or  in the air or 179179 on the ground on the ground

�.� Request AI Tow Plane�.� Request AI Tow Plane

Aerotow tab has a button that inserts AI planes into the game, which will take theAerotow tab has a button that inserts AI planes into the game, which will take the
role of a tug. AI planes have a very limited level of control by SimConnect, sorole of a tug. AI planes have a very limited level of control by SimConnect, so
their effectiveness relies on many conditions, which you should know before use.their effectiveness relies on many conditions, which you should know before use.

Two different modes available (depend on selected Two different modes available (depend on selected Realistic Tow PlaneRealistic Tow Plane
proceduresprocedures option): immediate take off or taxiing from the parking. option): immediate take off or taxiing from the parking.

To create AI tow plane To create AI tow plane anywhereanywhere::

1. Press Press Connect Connect buttonbutton
2. Ensure that Ensure that Realistic Tow Plane proceduresRealistic Tow Plane procedures option is  option is disableddisabled ( (SettingsSettings

tab)tab)
3. Open Open AerotowAerotow tab tab



4. Choose suitable for take off position (at least 500m of clean area in front ofChoose suitable for take off position (at least 500m of clean area in front of
you)you)

5. Remember that plane always turn Remember that plane always turn NorthNorth after take off after take off
6. Choose ElasticityChoose Elasticity, , Connection PointConnection Point and  and AI Tow PlaneAI Tow Plane parameters ( parameters (ScanScan

rangerange and  and Scanning typeScanning type will be set automatically) will be set automatically)
7. Notice that you can choose only planes from the top part of the list (others willNotice that you can choose only planes from the top part of the list (others will

not move after insertion); custom planes allowed (you can find full list of yournot move after insertion); custom planes allowed (you can find full list of your
aircraft in Developer > Aircraft Selection window), but it this mode some/mostaircraft in Developer > Aircraft Selection window), but it this mode some/most
of them will not move after insertionof them will not move after insertion

8. Press Press AI TOWAI TOW  buttonbutton
9. In 5 seconds tow plane will appear in front of youIn 5 seconds tow plane will appear in front of you

10. It will take off immediately, so be ready to avoid buildings and trees as there isIt will take off immediately, so be ready to avoid buildings and trees as there is
no altitude control for this kind of AI aircraftno altitude control for this kind of AI aircraft

11. tow plane will lift to the [launch position height] + 7000ft and then just follow totow plane will lift to the [launch position height] + 7000ft and then just follow to
the north,  so you should release rope until thenthe north,  so you should release rope until then

12. press press STOP STOP button to release tow rope and disable scanning (it consume CPUbutton to release tow rope and disable scanning (it consume CPU
power)power)

To create AI tow plane on the To create AI tow plane on the airfield parkingairfield parking::

1. choose the airfield with parking spotschoose the airfield with parking spots
2. set as Departure point parking or runway positionset as Departure point parking or runway position
3. set Destination for the flight plan, it can be another airfield or custom location;set Destination for the flight plan, it can be another airfield or custom location;

without destination, tow plane may appear in the wrong airfield (last one usedwithout destination, tow plane may appear in the wrong airfield (last one used
for the flight plan)!for the flight plan)!

4. start the flightstart the flight
5. Press Press Connect Connect buttonbutton
6. Ensure that Ensure that Realistic Tow Plane proceduresRealistic Tow Plane procedures option is  option is enabledenabled ( (SettingsSettings

tab)tab)
7. Open Open AerotowAerotow tab tab
8. Choose ElasticityChoose Elasticity, , Connection PointConnection Point and  and AI Tow PlaneAI Tow Plane parameters ( parameters (ScanScan

rangerange and  and Scanning typeScanning type will be set automatically) will be set automatically)
9. You can choose any plane from the listYou can choose any plane from the list

10. Press Press AI TOWAI TOW button button



11. In 5 seconds tow plane will appear on one of the parkingIn 5 seconds tow plane will appear on one of the parking
12. If it did not appear, all parking spaces are busy, or airfield scene not configuredIf it did not appear, all parking spaces are busy, or airfield scene not configured

properly (example of working airfields: properly (example of working airfields: EDWWEDWW and  and EDPNEDPN), or you have not set), or you have not set
flight plan properlyflight plan properly

13. AI will proceed to taxiing, respecting ATC commandsAI will proceed to taxiing, respecting ATC commands
14. it can stuck because some other object blocking the movement – otherit can stuck because some other object blocking the movement – other

airplane, ground service unit, your glider; if it stay in one place rotatingairplane, ground service unit, your glider; if it stay in one place rotating
continuously, something wrong, so you can try to add new onecontinuously, something wrong, so you can try to add new one

15. if AI plane started to move in opposite to runway direction (into nearby forestif AI plane started to move in opposite to runway direction (into nearby forest
for example), it is not trying to hijack you, just don’t know where to go becausefor example), it is not trying to hijack you, just don’t know where to go because
this airfield does not have taxiwaysthis airfield does not have taxiways

16. if it appear too far away from you, it will teleported near to you and then both ofif it appear too far away from you, it will teleported near to you and then both of
you follow to the runwayyou follow to the runway

17. you will be towed by the plane on the ground as well; that does not happen inyou will be towed by the plane on the ground as well; that does not happen in
real life but only workaround as small airfields does not have push backreal life but only workaround as small airfields does not have push back
servicesservices

18. once AI plane reached runway, it will contact ATC to request take offonce AI plane reached runway, it will contact ATC to request take off
19. after approval, it will take position on the runway and take off; it may happenafter approval, it will take position on the runway and take off; it may happen

that you are not aligned on the runway properlythat you are not aligned on the runway properly
20. after take off follow tow plane until it reach maximum altitude (it may be lessafter take off follow tow plane until it reach maximum altitude (it may be less

than you desire)than you desire)
21. press press STOP STOP button to release tow rope and disable scanning (it consume CPUbutton to release tow rope and disable scanning (it consume CPU

power)power)

�. Catapult�. Catapult

�.� User interface�.� User interface

1. Takeoff SpeedTakeoff Speed will set the maximum speed of the catapult. When this speed will set the maximum speed of the catapult. When this speed
value is reached, engines only will be the source of acceleration.value is reached, engines only will be the source of acceleration.

2. Ready to launchReady to launch can be pressed when parking brakes engaged. Press the can be pressed when parking brakes engaged. Press the
button again to initiate acceleration.button again to initiate acceleration.

�.� How to use�.� How to use



Catapult is a simple script that acceleratesCatapult is a simple script that accelerates
aircraft to the selected airspeed. Launchaircraft to the selected airspeed. Launch
aborts in case if preferred speed wasaborts in case if preferred speed was
reached, or aircraft takes off.reached, or aircraft takes off.

1. as aircraft experience significantas aircraft experience significant
overload during launch, you need tooverload during launch, you need to
disable crashes in the game settings,disable crashes in the game settings,
or enable Developer modeor enable Developer mode

2. take launching position – it can be ontake launching position – it can be on
the carrier or on the land, just be surethe carrier or on the land, just be sure
you have enough space to take offyou have enough space to take off

3. Engage parking brakesEngage parking brakes
4. set set Takeoff SpeedTakeoff Speed value – catapult will value – catapult will

accelerate aircraft to this speedaccelerate aircraft to this speed
5. press press Ready to launchReady to launch  buttonbutton
6. set required throttles level (normally about 80%)set required throttles level (normally about 80%)
7. Disengage parking brakesDisengage parking brakes and aircraft will receive acceleration immediately and aircraft will receive acceleration immediately

�. Arresting gear�. Arresting gear

�.� User interface�.� User interface

1. Full Stop TimeFull Stop Time will determine how long landing running takes. Lower value will determine how long landing running takes. Lower value
will cause stronger drag force – 2-3 seconds can be set for carrier jets withwill cause stronger drag force – 2-3 seconds can be set for carrier jets with
higher landing speed. For slow planes value can be 4-5 seconds for smoothhigher landing speed. For slow planes value can be 4-5 seconds for smooth
deceleration.deceleration.

2. Deploy tailhookDeploy tailhook should be pressed at the same time as gear extraction should be pressed at the same time as gear extraction
triggered.triggered.

�.� How to use�.� How to use

Arresting gear does not have any kind of hook/string collision calculations andArresting gear does not have any kind of hook/string collision calculations and
activated after plane touching surface by one of the wheels or appear lower thanactivated after plane touching surface by one of the wheels or appear lower than
0.3m to the surface, while tailhook extracted (regardless is it presented/animated0.3m to the surface, while tailhook extracted (regardless is it presented/animated



in the aircraft model or not) and speedin the aircraft model or not) and speed
more than 40 knots. After landing, aircraftmore than 40 knots. After landing, aircraft
experience negative drag force for theexperience negative drag force for the
selected period of time. However,selected period of time. However,
deceleration is limited to 5G and if landingdeceleration is limited to 5G and if landing
speed is too high, aircraft will roll morespeed is too high, aircraft will roll more
then ~100m which will cause arrestingthen ~100m which will cause arresting
string failure.string failure.

1. while in the air, set required while in the air, set required Full StopFull Stop
TimeTime value – depends on landing value – depends on landing
speed of your aircraft, set lower valuespeed of your aircraft, set lower value
for high speed aircraftfor high speed aircraft

2. press press Deploy tailhookDeploy tailhook  button, if modelbutton, if model
has animated tailhook – it will behas animated tailhook – it will be
deployeddeployed

3. land on the carrier, or runway, or field;land on the carrier, or runway, or field;
after first touchdown aircraft will experience drag force until full stopafter first touchdown aircraft will experience drag force until full stop

4. if you are not able to stop in ~100m, arresting string will fail (can be disabled inif you are not able to stop in ~100m, arresting string will fail (can be disabled in
settings)settings)

5. after full stop string will be released and tailhook will be retracted automaticallyafter full stop string will be released and tailhook will be retracted automatically

�. Thermals�. Thermals

�.� User interface�.� User interface

1. Amount of loaded into program memory thermals, it includes both CSV andAmount of loaded into program memory thermals, it includes both CSV and
API points.API points.

2. LittleNavMap thermals mapLittleNavMap thermals map button can be used to load manually made button can be used to load manually made
thermals map in CSV format. You can load several maps one by one.thermals map in CSV format. You can load several maps one by one.

3. Thermal.KK7.chThermal.KK7.ch button will toggle automatic hotspots loading for current area. button will toggle automatic hotspots loading for current area.
You can check coverage on the You can check coverage on the service websiteservice website < https://thermal.kk7.ch/>  < https://thermal.kk7.ch/> ,,
you need to check you need to check HotSpotsHotSpots option in the left top corner to see the data option in the left top corner to see the data
loaded by Kinetic. This is an online method and requires an internetloaded by Kinetic. This is an online method and requires an internet
connection.connection.

https://thermal.kk7.ch/


4. openAIP.net toggle automatic hotspotsopenAIP.net toggle automatic hotspots
loading for current area, coverage canloading for current area, coverage can
be checked on be checked on service websiteservice website < <
http://maps.openaip.net/> http://maps.openaip.net/> . This is an. This is an
offline method and doesn’t requireoffline method and doesn’t require
internet connection.internet connection.

5. Clear thermals dataClear thermals data button will clear button will clear
thermals list, both CSV and API data.thermals list, both CSV and API data.

6. After clicking on After clicking on CSVCSV icon, thermal icon, thermal
data can be saved as a CSV file anddata can be saved as a CSV file and
then loaded in LittleNavMap asthen loaded in LittleNavMap as
Userpoints.Userpoints.

7. After clicking on After clicking on APIAPI icon, the service icon, the service
map will be opened in the web browser.map will be opened in the web browser.

8. Thermals heightThermals height dropdown affect all dropdown affect all
API thermals, and CSV thermals withAPI thermals, and CSV thermals with
elevation near to 0 (+/- 1000). You could set it manually as the lower edge ofelevation near to 0 (+/- 1000). You could set it manually as the lower edge of
the clouds. Exception is ALBATROSS application that will set this valuethe clouds. Exception is ALBATROSS application that will set this value
automatically.automatically.

9. Thermals typeThermals type dropdown affects behavior of the thermals in different wind dropdown affects behavior of the thermals in different wind
conditions.conditions.

10. Enable thermalsEnable thermals button activate updraft calculations while you are inside of button activate updraft calculations while you are inside of
the thermal.the thermal.

�.� How thermals works�.� How thermals works

Thermals are just coordinate points placed into program memory. Assistant doesThermals are just coordinate points placed into program memory. Assistant does
not affect the weather system anyhow, even wind,  as such capabilities are notnot affect the weather system anyhow, even wind,  as such capabilities are not
implemented in SimConnect of MSFS, so lift calculations happen outside of theimplemented in SimConnect of MSFS, so lift calculations happen outside of the
game.game.

Thermal lift power calculated from different modifiers:Thermal lift power calculated from different modifiers:

how close plane to the center of the thermal (horizontally, nonlinear)how close plane to the center of the thermal (horizontally, nonlinear)

how close plane to the top, from 0 at the ground level to 1 at elevation level,how close plane to the top, from 0 at the ground level to 1 at elevation level,
nonlinear; also, inversion layer exist up to 500ft above elevationnonlinear; also, inversion layer exist up to 500ft above elevation  

http://maps.openaip.net/


pitch/bank angle modifierpitch/bank angle modifier

wind (0-50m/s then thermal disappear): width increasing from 100% to 200%,wind (0-50m/s then thermal disappear): width increasing from 100% to 200%,
strength decreasing from 100% to 0%, Static/Lean/Drift thermal behavior typestrength decreasing from 100% to 0%, Static/Lean/Drift thermal behavior type
on choice (drift positions will be reset after each thermals data reload)on choice (drift positions will be reset after each thermals data reload)

weather: disappear while raining, 20% – snowingweather: disappear while raining, 20% – snowing

time of the day: 100% daytime (no sun height dependency), 10% dawn, 0%time of the day: 100% daytime (no sun height dependency), 10% dawn, 0%
dusk/nightdusk/night

forward velocity modifier to prevent overspeedforward velocity modifier to prevent overspeed

additional forward speed compensation as SimConnect script creatingadditional forward speed compensation as SimConnect script creating
unwanted drag forceunwanted drag force

Smooth transition of ambient modifiers simulated by transformation delay, so it isSmooth transition of ambient modifiers simulated by transformation delay, so it is
normal that effect will not change immediately after weather change, teleportationnormal that effect will not change immediately after weather change, teleportation
or flight start.or flight start.

�.� Create thermals map manually�.� Create thermals map manually

1. Open flight plan in Open flight plan in Little NavmapLittle Navmap (or just to navigate to the area where are (or just to navigate to the area where are
you planning to glide)you planning to glide)

2. create Userpoints at thermals locations with these parameters: ident –create Userpoints at thermals locations with these parameters: ident –
“thermal”, type – “location”, tags – thermal radius (in nautical miles, digit only)“thermal”, type – “location”, tags – thermal radius (in nautical miles, digit only)
– space – thermal power in knots (optional), elevation (above ground in– space – thermal power in knots (optional), elevation (above ground in
thermal location, in feet; if less than 1000 – thermal height will rely on selectedthermal location, in feet; if less than 1000 – thermal height will rely on selected
by user by user Thermals heightThermals height option, while elevation value became modifier) option, while elevation value became modifier)

3. Choose menu item Choose menu item UserpointsUserpoints –  – Export CSVExport CSV

Examples:Examples:

Elevation: Elevation: 30003000  
Tag: Tag: 11  
if ground level at if ground level at 500500 feet  feet MSLMSL, thermal top will be at , thermal top will be at 3500ft3500ft ( (MSLMSL,,
barometric altitude), barometric altitude), 1nm1nm radius, lift power  radius, lift power 10kn10kn by default by default

Elevation: Elevation: 25002500  
Tag: Tag: 1.5 101.5 10  



thermal top at thermal top at 3000ft MSL3000ft MSL, , 1.5nm1.5nm radius, best lift inside of thermal will be radius, best lift inside of thermal will be
~8kn~8kn on the top, in the middle – about  on the top, in the middle – about 5kn5kn

Elevation: Elevation: 500500  
Tag:Tag: 0.5 0.5  
thermal height will be measured by thermal height will be measured by MSLMSL value, selected by user in value, selected by user in
Thermals tab (version 0.8 and later), if it set Thermals tab (version 0.8 and later), if it set 60006000, then thermal height will, then thermal height will
be be 6500ft6500ft above sea level,  above sea level, 0.5nm0.5nm radius,  radius, 10kn10kn best lift value best lift value

Elevation: Elevation: -500-500  
Tag:Tag: 2 8 2 8  
with same clouds level value, top of the thermal is with same clouds level value, top of the thermal is 5500ft5500ft above sea above sea
level, level, 2nm2nm radius radius 8kn 8kn (v0.8+ as well) (v0.8+ as well)

�.� Load CSV thermals map�.� Load CSV thermals map

1. Press Press LittleNavMap thermals mapLittleNavMap thermals map button on  button on ThermalsThermals tab tab
2. Select Select CSVCSV file file
3. Set Set Thermals height Thermals height value to fit current weather preset (altitude of lowervalue to fit current weather preset (altitude of lower

clouds layer, 10000 if no clouds at all); only thermals with elevation value fromclouds layer, 10000 if no clouds at all); only thermals with elevation value from
-1000 to 1000 will be affected-1000 to 1000 will be affected

4. Press Press Enable ThermalsEnable Thermals button button

https://msfs.touching.cloud/wp-content/uploads/2020/12/lnm-1.jpg


< https://msfs.touching.cloud/wp-content/uploads/2020/12/lnm-1.jpg>< https://msfs.touching.cloud/wp-content/uploads/2020/12/lnm-1.jpg>

�.� Load API thermals�.� Load API thermals

You can load high lift areas data from You can load high lift areas data from thermal.kk7.chthermal.kk7.ch < <
https://thermal.kk7.ch/> https://thermal.kk7.ch/> and and maps.openAIP.netmaps.openAIP.net < http://maps.openaip.net/> < http://maps.openaip.net/>
API services:API services:

Both online services provide hotspots data mainly around Alps and some otherBoth online services provide hotspots data mainly around Alps and some other
areas. Coverage is low globally, but some locations are fully filled.areas. Coverage is low globally, but some locations are fully filled.

Follow website and find preferred soaring locationFollow website and find preferred soaring location

Enable Hotspots layer (kk7 top left corner, openAIP – right sidebar)Enable Hotspots layer (kk7 top left corner, openAIP – right sidebar)

If you see hotspots in your area, launch the game, press If you see hotspots in your area, launch the game, press ConnectConnect button, and button, and
then then THERMAL.KK7.CHTHERMAL.KK7.CH or or  openAIP.netopenAIP.net  
Program will load hotspots in your grid, you can see precise amount on top ofProgram will load hotspots in your grid, you can see precise amount on top of
the formthe form

You can use custom (CSV) thermals map together with API dataYou can use custom (CSV) thermals map together with API data

Set Set Thermals height Thermals height value to fit current weather preset, otherwise thermalsvalue to fit current weather preset, otherwise thermals
effectiveness will be unrealisticeffectiveness will be unrealistic

Press Press Enable ThermalsEnable Thermals  buttonbutton

In the flight, when you reach bounds of loaded area, program will updateIn the flight, when you reach bounds of loaded area, program will update
thermals data automaticallythermals data automatically

thermals strength and radius calculated from probability factor (radius vary 0.3-thermals strength and radius calculated from probability factor (radius vary 0.3-
0.9nm, strength 2-6kn)0.9nm, strength 2-6kn)

https://msfs.touching.cloud/wp-content/uploads/2020/12/lnm-1.jpg
https://thermal.kk7.ch/
http://maps.openaip.net/


< https://msfs.touching.cloud/wp-content/uploads/2020/12/thermals2-1.jpg>< https://msfs.touching.cloud/wp-content/uploads/2020/12/thermals2-1.jpg>
While you are inside of thermal cylinder, you will experience additional lift;While you are inside of thermal cylinder, you will experience additional lift;
maximum lift power in the center of the cylinder, at selected altitude, after thatmaximum lift power in the center of the cylinder, at selected altitude, after that
power will decrease smoothly. To debug value, press power will decrease smoothly. To debug value, press Thermals debug infoThermals debug info
button at the bottom.button at the bottom.

�. Settings�. Settings

1. AutoconnectAutoconnect not implemented yet not implemented yet
2. Display ingame tipsDisplay ingame tips will make pop-up will make pop-up

Kinetic notifications appear in theKinetic notifications appear in the
game. Because of MSFS bug, theygame. Because of MSFS bug, they
always stay on the screen for 10always stay on the screen for 10
seconds even after a new tooltip isseconds even after a new tooltip is
inserted.inserted.

3. Realistic FailuresRealistic Failures affect winch, affect winch,
aerotow and arresting gear. It makesaerotow and arresting gear. It makes
the failure threshold lower so you needthe failure threshold lower so you need
to be more accurate.to be more accurate.

4. Random FailuresRandom Failures cause short time cause short time
peaks of the winch/tow cable tension.peaks of the winch/tow cable tension.
Each step increases chances andEach step increases chances and
multiplies the tension peak. multiplies the tension peak. TrainingTraining

https://msfs.touching.cloud/wp-content/uploads/2020/12/thermals2-1.jpg


ModeMode is like using damaged rope that will fail during the next launch but you is like using damaged rope that will fail during the next launch but you
still have a chance to avoid it.still have a chance to avoid it.

5. Enabled Enabled Realistic RestrictionsRealistic Restrictions forbid to use winch and tow in the air, connect forbid to use winch and tow in the air, connect
tow rope with parking brakes engaged.tow rope with parking brakes engaged.

6. With disabled With disabled Realistic Tow Plane proceduresRealistic Tow Plane procedures, AI towplane inserted in front, AI towplane inserted in front
of you, and taking off happen immediately. AI planes in this mode alwaysof you, and taking off happen immediately. AI planes in this mode always
follow north and do not avoid terrain or buildings. With enabled follow north and do not avoid terrain or buildings. With enabled Realistic TowRealistic Tow
Plane proceduresPlane procedures towplane will be inserted on the parking with further ATC towplane will be inserted on the parking with further ATC
guidance.guidance.  

7. XCSoar data exportXCSoar data export disabled due to issues disabled due to issues  
8. Play soundsPlay sounds enable sounds notifications created by Kinetic events.  enable sounds notifications created by Kinetic events. VolumeVolume

can be adjusted with a slider.can be adjusted with a slider.
9. News and updates indicatorNews and updates indicator – left click open news page in web browser, – left click open news page in web browser,

right  – reset counter.right  – reset counter.
10. Always on topAlways on top
11. Transparent modeTransparent mode

��. Debug window��. Debug window

1. Debug window toggle buttonDebug window toggle button
2. Main window toggle buttonMain window toggle button
3. Current towplaneCurrent towplane
4. Active/closest targetActive/closest target
5. Winch positionWinch position
6. Thermal area (transparency dependsThermal area (transparency depends

on current modifier)on current modifier)
7. Wind direction and strength (knots)Wind direction and strength (knots)
8. Vertical wind indication (+/- 20 knots)Vertical wind indication (+/- 20 knots)
9. Systems messages logSystems messages log

��. Controls configure��. Controls configure



to bind keyboard/joystick/mouse button to the Assistant function, press to bind keyboard/joystick/mouse button to the Assistant function, press CTRLCTRL
icon near to event buttonicon near to event button

select desired MSFS sim variable (currently lights only)select desired MSFS sim variable (currently lights only)

configure this event in MSFS controls settingsconfigure this event in MSFS controls settings

press this button twice in short period of time (with interval between 0.25-1.0press this button twice in short period of time (with interval between 0.25-1.0
seconds), process can be described as “blink by lights”seconds), process can be described as “blink by lights”

��. Issues��. Issues

if winch/tow does not work for some gliders in v0.8.4, update to newer versionif winch/tow does not work for some gliders in v0.8.4, update to newer version

to fix program crash on attempt to load KK7 hotspots data, update to versionto fix program crash on attempt to load KK7 hotspots data, update to version
0.8.1 or later0.8.1 or later

to fix “Flight plan not found” error after AI TOW button pressed, updateto fix “Flight plan not found” error after AI TOW button pressed, update
program to the version 0.7.1 or laterprogram to the version 0.7.1 or later

if you have problem with loading CSV file into assistant (thermals map), updateif you have problem with loading CSV file into assistant (thermals map), update
to version 0.7 or laterto version 0.7 or later

if some other mods, add-ons or SimConnect utilities does not work properlyif some other mods, add-ons or SimConnect utilities does not work properly
after Kinetic Assistant usage, start Assistant version 0.7 or later and connect toafter Kinetic Assistant usage, start Assistant version 0.7 or later and connect to
the game once to fix the problem; if did not helped – remove SimConnect.cfgthe game once to fix the problem; if did not helped – remove SimConnect.cfg
file from My Documents manually)file from My Documents manually)

planes, controlled by other players, does not appear in nearby objects list dueplanes, controlled by other players, does not appear in nearby objects list due
to SimConnect bug; as temporary workaround – pilot inside of the otherto SimConnect bug; as temporary workaround – pilot inside of the other
player’s plane can be selected as towing target. That means planes withoutplayer’s plane can be selected as towing target. That means planes without
pilot objects inside can’t be used as a tow plane. But some stock aircraft haspilot objects inside can’t be used as a tow plane. But some stock aircraft has
issue with pilots entities, they are not moving together with airplane, so can’tissue with pilots entities, they are not moving together with airplane, so can’t
be used for multiplayer towing (only as AI tow plane, list in the description)be used for multiplayer towing (only as AI tow plane, list in the description)

inserted AI planes often does not act predictable – taxiing in opposite directioninserted AI planes often does not act predictable – taxiing in opposite direction
to the runway (no taxiways in this airfield), stuck in the taxiing process (someto the runway (no taxiways in this airfield), stuck in the taxiing process (some
other game object blocking his movements), gain altitude too fast, or to slow,other game object blocking his movements), gain altitude too fast, or to slow,
or crash into buildings, etc. be ready for surprises.or crash into buildings, etc. be ready for surprises.

no visible winch cable, arresting strings, launchpadno visible winch cable, arresting strings, launchpad

old tooltip does not disappear after new one added (SimConnect bug)old tooltip does not disappear after new one added (SimConnect bug)

no launchpad animation (even if it exists) due to disabled related sim variableno launchpad animation (even if it exists) due to disabled related sim variable

catapult and arresting gear can be activated anywhere, not only on carrierscatapult and arresting gear can be activated anywhere, not only on carriers



Kinetic Assistant v�.�.�Kinetic Assistant v�.�.�

nav screen with interactive elements indication – winch, tow plane,nav screen with interactive elements indication – winch, tow plane,
thermalsthermals

SimConnect data exchange frequency slider (move left in case ofSimConnect data exchange frequency slider (move left in case of
performance drop, vertical wind)performance drop, vertical wind)

tow plane scan radius field replaced with nav scale slidertow plane scan radius field replaced with nav scale slider

AI tow plane desired speed field addedAI tow plane desired speed field added

AI tow plane heading issue fixed (no longer heading north)AI tow plane heading issue fixed (no longer heading north)

NMEA/XCSoar data transfer (experimental)NMEA/XCSoar data transfer (experimental)

thermals simulation code revisedthermals simulation code revised

bank leveling continuing up to 3 seconds after winch launchbank leveling continuing up to 3 seconds after winch launch

additional debug messagesadditional debug messages

thermals CSV export issue fixedthermals CSV export issue fixed

thermal maximum strength point lowered to the 2/3 of the thermalthermal maximum strength point lowered to the 2/3 of the thermal
elevation (above ground)elevation (above ground)

pause detection issue fixedpause detection issue fixed

Kinetic Assistant v�.�.�.�Kinetic Assistant v�.�.�.�

Discus 2.5  winch/tow hotfixDiscus 2.5  winch/tow hotfix

Kinetic Assistant v�.�.�Kinetic Assistant v�.�.�

landing/taxi light blinking while connected to the tow plane (to make itlanding/taxi light blinking while connected to the tow plane (to make it
obvious for the tow plane pilot)obvious for the tow plane pilot)



thermals wind modifier (0-50m/s then thermal disappear): width increasingthermals wind modifier (0-50m/s then thermal disappear): width increasing
from 100% to 200%, strength decreasing from 100% to 0%,from 100% to 200%, strength decreasing from 100% to 0%,
Static/Lean/Drift thermal behavior on choice (drift positions will be resetStatic/Lean/Drift thermal behavior on choice (drift positions will be reset
after each thermals data reload)after each thermals data reload)

thermals weather modifier: disappear while raining, 20% – snowingthermals weather modifier: disappear while raining, 20% – snowing

thermals time of the day modifier: 100% daytime (no sun heightthermals time of the day modifier: 100% daytime (no sun height
dependency), 10% dawn, 0% dusk/nightdependency), 10% dawn, 0% dusk/night

catapult holds aircraft at launch position position until catapult triggercatapult holds aircraft at launch position position until catapult trigger

arrestor vertical force decreased to avoid immediate stoparrestor vertical force decreased to avoid immediate stop

Kinetic Assistant v�.�.�Kinetic Assistant v�.�.�

Hotspots import generated by OpenAIP.net API (offline)Hotspots import generated by OpenAIP.net API (offline)

News notifier (settings page)News notifier (settings page)

Slew mode pauses any kinetic activitySlew mode pauses any kinetic activity

Kinetic Assistant v�.�.�Kinetic Assistant v�.�.�

Always on top and Transparency checkboxes removed (available on theAlways on top and Transparency checkboxes removed (available on the
window bar)window bar)

20 seconds minimum KK7 data update interval (to prevent server flooding20 seconds minimum KK7 data update interval (to prevent server flooding
by possible code issue)by possible code issue)

KK7 thermals button state save (no need to toggle it after each programKK7 thermals button state save (no need to toggle it after each program
launch, just press Enable Thermals to update the data)launch, just press Enable Thermals to update the data)

Solved KK7 data load precision issues, program request data for singleSolved KK7 data load precision issues, program request data for single
grid cell (3 on far north/south) to avoid clippinggrid cell (3 on far north/south) to avoid clipping

API thermals filtering, too keep distance between received hotspotsAPI thermals filtering, too keep distance between received hotspots

API thermals maximum strength decreasedAPI thermals maximum strength decreased



Kinetic Assistant v�.�.�Kinetic Assistant v�.�.�

Application crash fixed on attempt to load KK7 hotspots dataApplication crash fixed on attempt to load KK7 hotspots data

Background load of hotspots data improved when pilot get outside ofBackground load of hotspots data improved when pilot get outside of
loaded arealoaded area

KK7 data export into CSV fixed (actual values will be inserted intoKK7 data export into CSV fixed (actual values will be inserted into
Elevation/Tag values)Elevation/Tag values)

Kinetic Assistant v�.�Kinetic Assistant v�.�

transparency optiontransparency option

partially working Always on top feature fixedpartially working Always on top feature fixed

Winch Initial acceleration field addedWinch Initial acceleration field added

Custom AI tow plane name support (most aircraft will not take off withoutCustom AI tow plane name support (most aircraft will not take off without
taxiing; names list can be found in Developer menu -> Aircraft Selector)taxiing; names list can be found in Developer menu -> Aircraft Selector)

Automatic thermals data load from thermal.kk7.ch service (experimental!Automatic thermals data load from thermal.kk7.ch service (experimental!
coverage is limited, check their website to choose supported location)coverage is limited, check their website to choose supported location)

Thermals height field, for thermal.kk7.ch data or CSV thermals with 0Thermals height field, for thermal.kk7.ch data or CSV thermals with 0
elevation set; should match altitude of lower clouds layer in the game (inelevation set; should match altitude of lower clouds layer in the game (in
feet)feet)

Thermal Clear button added, as now several sources can be used sameThermal Clear button added, as now several sources can be used same
time – multiple CSVs made in LittleNavMap and thermal.kk7.ch servertime – multiple CSVs made in LittleNavMap and thermal.kk7.ch server
datadata

Thermal debug data moved into bottom windowThermal debug data moved into bottom window

Winch/Tow rope random failures option (chances still depend on tension,Winch/Tow rope random failures option (chances still depend on tension,
Training Mode is like use damaged rope that will fail during next launch)Training Mode is like use damaged rope that will fail during next launch)

AI tow plane altitude limit depend on launching position altitude (fix forAI tow plane altitude limit depend on launching position altitude (fix for
mounting area)mounting area)

Kinetic Assistant v�.�.�Kinetic Assistant v�.�.�



Error “Flight plan does not exist” in Steam version of MSFS fixedError “Flight plan does not exist” in Steam version of MSFS fixed

Kinetic Assistant v�.�Kinetic Assistant v�.�

compatibility issue with CJ4 mod fixed in fsConnect.dll (start Assistant andcompatibility issue with CJ4 mod fixed in fsConnect.dll (start Assistant and
connect to the game once to fix the problem, if did not helped – removeconnect to the game once to fix the problem, if did not helped – remove
SimConnect.cfg file from My Documents manually)SimConnect.cfg file from My Documents manually)

thermal parsing script decimal delimiter related issue fixedthermal parsing script decimal delimiter related issue fixed

AI tow plane insertion (immediate takeoff or taxiing, depends on RealisticAI tow plane insertion (immediate takeoff or taxiing, depends on Realistic
Tow Plane procedures option)Tow Plane procedures option)

warning if program launched from Community folder (move program folderwarning if program launched from Community folder (move program folder
outside of Community directory)outside of Community directory)

new settings optionsnew settings options

cable tension calculation improvementscable tension calculation improvements

If you have a problem with DG808S (v0.6 or earlier) when you select parking asIf you have a problem with DG808S (v0.6 or earlier) when you select parking as
departure point (glider appear in the air), unpack departure point (glider appear in the air), unpack these FLT filesthese FLT files < <
https://drive.google.com/file/d/16ZhBG9NJQ0p1k7Xl-aoSi9WmEi-https://drive.google.com/file/d/16ZhBG9NJQ0p1k7Xl-aoSi9WmEi-
tBnGX/view?usp=sharing> tBnGX/view?usp=sharing> into community folder (overwrite on request). Forinto community folder (overwrite on request). For
later glider version, you don’t need these files.later glider version, you don’t need these files.

If you have downloaded this version in less than 3 hours from release momentIf you have downloaded this version in less than 3 hours from release moment
and experience problem with settings being not saved, download this archiveand experience problem with settings being not saved, download this archive
again and update your filesagain and update your files

Kinetic Assistant v�.�Kinetic Assistant v�.�TESTTEST

development versiondevelopment version

https://drive.google.com/file/d/16ZhBG9NJQ0p1k7Xl-aoSi9WmEi-tBnGX/view?usp=sharing


Kinetic Assistant v�.�Kinetic Assistant v�.�

* Aerotow tab – both AI and player’s planes attachment supported, can be* Aerotow tab – both AI and player’s planes attachment supported, can be
activated only on the groundactivated only on the ground  
* rope tension length limited to 5 meters* rope tension length limited to 5 meters  
* glider bank leveling before winch start (on runway only)* glider bank leveling before winch start (on runway only)  
* nose connection point (both winch and tow)* nose connection point (both winch and tow)  
* thermal “Tags” value can contain both radius and strength, like “0.5 12” means* thermal “Tags” value can contain both radius and strength, like “0.5 12” means
radius 0.5nm maximum with strength 12knradius 0.5nm maximum with strength 12kn  
* multiply thermals modifiers for the smooth experience* multiply thermals modifiers for the smooth experience  
* thermal lift calculation results rendering* thermal lift calculation results rendering  
* thermal lift disappear at airspeed greater than 180kn to avoid overspeed* thermal lift disappear at airspeed greater than 180kn to avoid overspeed

Kinetic Assistant v�.�Kinetic Assistant v�.�

* sound notifications setting added* sound notifications setting added  
* MSFS controls tracking (light evens can be linked with program functions)* MSFS controls tracking (light evens can be linked with program functions)  
* winch launch button removed (parking brakes disengage will be used to trigger* winch launch button removed (parking brakes disengage will be used to trigger
launch)launch)  
* Thermals tab added (CSV userpoints list generated by Little Navmap)* Thermals tab added (CSV userpoints list generated by Little Navmap)  
* Winch cable speed depend on tension and climb angle* Winch cable speed depend on tension and climb angle  
* rotation and vertical speed stabilization of the aircraft while catapult or arresting* rotation and vertical speed stabilization of the aircraft while catapult or arresting
gear is activegear is active  
* arresting string can be activated only at speed 20kn or higher* arresting string can be activated only at speed 20kn or higher  
* maximum arresting string effectiveness limited to 5G* maximum arresting string effectiveness limited to 5G  
* maximum arresting string working length set as 100m* maximum arresting string working length set as 100m

Kinetic Assistant v�.�Kinetic Assistant v�.�

Winch code improvedWinch code improved

Settings pageSettings page



Catapult and Arrestor sections addedCatapult and Arrestor sections added

Kinetic Assistant v�.�Kinetic Assistant v�.�

Initial release, Winch sectionInitial release, Winch section
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